
 

Instruction Manual  
For New Radiation scanner Model 900  

 

 

                   

 

Coliy Technology GmbH 

Version No.：J280-1

I 



 

I 

Contents 

Introduction .................................................................................................... 1 

Control Panel .................................................................................................. 4 

Operating Instruction .................................................................................... 6 

Ray selection switch................................................................................... 6 

Indicating current radiation: ....................................................................... 7 

Sv/h and Rem/h indicating unit convert..................................................... 7 

Dose accumulation Sv................................................................................ 7 

Pulse counting ............................................................................................ 9 

Indicating the pulse rate：CPS/CPM ...................................................... 12 

Setup menu ：SETUP............................................................................. 12 

Calibration factor...................................................................................... 13 

Maximum record ：MAX....................................................................... 14 

Data storage ：SAVE.............................................................................. 16 

Data transfer：USB ................................................................................. 17 

Clear the stored data................................................................................. 18 

Power on / off ........................................................................................... 18 

Battery ...................................................................................................... 19 

Radiation Scanner Software........................................................................ 20 



 

II 

System requirements ................................................................................ 21 

Software installation................................................................................. 21 

Connecting Radiation Scanner................................................................. 22 

Solutions to the software stallation failure............................................... 24 

Read online Data ...................................................................................... 25 

Intervals Setting........................................................................................ 27 

Alarm Setting ........................................................................................... 28 

Save Online Data...................................................................................... 29 

Read Radiation Scanner Recorded Data .................................................. 30 

Save Radiation Scanner Recorded Data................................................... 31 

Delete Radiation Scanner Recorded Data................................................ 32 

Option....................................................................................................... 33 

About ........................................................................................................ 36 

Technical data：........................................................................................... 38 

Warranty....................................................................................................... 40 

Appendix ....................................................................................................... 41 

Radiation unit conversion formulas ......................................................... 41 

Calibration factor for Co-60 or Cs-137.................................................... 43 



 

Page1 

Introduction  

It’s a wise choice to use the Coliy new Radiation Scanner Model 

900 (below: Model 900) which is designed totally on new standard 

to develop the old devices in the ways of performance, operation 

and manual options. 

1. Comparing with old devices, Model 900 increase 

functions such as dose accumulating, maximum recording, 

hand-operated store, data transfer to PC in real-time, 

data analysis, etc. 

2. Employed the thin film switch. One push of a button  is 

enough to start radiation measurement and plentiful of 

data is available. 

3. Tested precision instrument. Each Coliy Radiation 

Scanner Model 900 is subjected to a final test 

supervised by the institute of radiation protection of 

a government controlled university of applied 

technology. 

4. All ray types: Model 900 can reliably measure not only 

γ rays, but α、β and X rays as well. 

5. Model 900 increases Power on/off switch which 

extremely extend the battery’s useful time. 

6. Low power consumption: Model 900 consumes very little 
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power. Due to use three AAA batteries, it’s very easy 

to change them. 

7. Large area of display: All values and settings are 

indicated on an extra-large display. 

8. Data storage: Model 900 carries high capacity internal 

memory to store values. No need to keep records by hand. 

Furthermore it supports data storage for 1 minute after 

power down. You don’t have to worry about losing data 

as changing battery. 

9. Evaluation by computer: The software which comes with 

Model 900 enables the computer to indicate the 

measuring data in real-time for you to monitor remotely, 

to evaluate and to store data at intervals which you 

can set as you will. 

10. Compact design: Model 900 is very compact in its 

dimensions, and small enough to fit a pocket. 

11. Certification: Model 900 has been tested by TUV (German 

Technical Control Board) for device safety. It means 

all European CE standards as well as the “FCC 15 

standards” of the USA. Model 900 may be carried on 

aircraft. 

12. Model 900 has two models: Model 900+ and Model 900 

(Simplified version). Model 900+ has functions such as 
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alarm,data storage, Maximum recording and 

communication with computer but Model 900 (simplified 

version) hasn’t.  
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Control Panel 

MODEL 900 PANEL 

 



Control Panel 

 

MODEL 900+ PANEL 

 

Model 900+ has functions such as alarm,data storage, Maximum 

recording and communication with computer but Model 900 

(simplified version) hasn’t. 
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Operating Instruction 

Ray selection switch 

Model 900 is equipped with high degree of Geiger counter tube 

enabling you to detect γray but also α、β、X ray. 

With the ray selection switch you can limit the ray types you 

want to measure: 

1. Set the selection to center position to detect γ ray. 

2. Move the switch to the left to measure γ+β ray. 

3. Move the switch to the right to measure α+γ+β ray. 

4. Put the switch to any position to detect X ray. 

For normal measuring, place the ray selection switch at center 

position. αand βray are limited in ranges to a few centimeters 

or meters, and can therefore be detected only when very close to 

the radiation source. 

Caution: Move switch tenderly in case of damage to sensor 

element.  
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(Image: Ray selection switch) 

In standard mode, Model 900 informs you quickly and reliably 

about current radiation exposure. 

Indicating current radiation: 

Pressing the  button puts Model 900 into standard mode, 

and its display show you the present radiation in microsievert per 

hour (μSv/h) – not only as a value but also in the form of a bar 

chart that varies with the displayed value. In order to visualize 

the volume of detected radiation, there is a bar diagram on the 

ground line of the display using symbols as 0.1,1,10,100. Note that 

for a small radiation value, this bar chart appears only as a single 

line.  

 

Sv/h and Rem/h indicating unit convert 

Pressing  button，the indicating unit convert between 

μSv/h and mR/h. The converting formula as following: 

10μSv/h=1mRem/h 

Dose accumulation Sv 

Model 900 can also be used as a dose accumulator to record the 

accumulated radiation value during a period of time. At first the 

initial value is in μSv. When the value is accumulated big enough 
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the device will convert the unit to mSv or Sv automatically on the 

display. 

 

Dose accumulation Button  

Pressing  button once to switch Model 900 to the dose 

accumulating mode, then the display indicates “μSv” icon. 

Pressing  button once more to end dose accumulating，the device 

will respond a short ring and indicate the current accumulated dose 

value on the display.  

 

Or pressing  button long for two seconds to set measure 

time，the display indicates two icons as “μSv” and“min”. 3 

digits show on the display and the default value is “060” that 

means 60 minutes. The Maximum time that can be set is 999 minutes. 

When the first digit （hundred’s place）blinks, you can set the 

number directly.  

- Pressing  button once to set number at tens place； 

- Pressing  button once more to set number at units place； 

- Pressing  button to withdraw into the previous mode； 

- Pressing  button for the third time to ensure the 

completion of time setting, and the display indicates the current 

setting time； 

- Pressing  button for the fourth time to enter the timing 
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dose accumulation mode, blinks the icon “TIME” on the top left 

of the display.  

Pressing  or  button to adjust the displayed value.  

If the measuring time was set, the device will buzz a short 

ring as time is up.  The display indicates the accumulated dose 

value during the setting period while the “TIME” icon stops 

blinking on the display. If you press the button while the setting 

time is not run out, the device will enter 

non-timing-dose-accumulation mode. Pressing the button long to 

enter again the timing dose accumulation mode. 

Three ways to stop measuring： 

-Under non-timing measure mode, pressing  button shortly 

for the second time to end accumulating，the measuring value 

indicates on the display. During the timing measure process, 

pressing the button shortly to enter non-timing accumulation mode.  

- Pressing  button long to enter timing mode and in the 

meantime the time is set as “000”. Confirm it and the measuring 

value is cleared. Then the default mode is to detect dose rate. 

- By choosing any other operating mode, the measuring result 

is disappeared. 

Pulse counting 

Model 900 can also be used as a normal Geiger counter, in which 
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case it simply counts the number of pulse received without 

converting them into the sievert unit (Dose unit, 1Sv=100Rem). 

Model 900 indicates the received pulses on the LCD display. 

Pulse counting button  

Press the  button once to switch Model 900 to the pulse 

count mode. The display then shows the pulse symbol. Press the 

 button again to end the pulse counting，And the device will 

show the current accumulated value and pulse symbol on the display 

with a short buzz.  

 

Or press the  button long for 2 seconds，if you want to 

set a measuring time. The display then shows the pulse symbol. 

Now the display indicates 3 digits with the default value 

“060”that means 60 minutes. The maximum that can be set is 

999 minute. When the first digit (hundred’s place）blinks, you 

can set the number directly.  

- Press the  button for the first time to set number at 

tens place； 

- Press the  button for the second time to set number at 

units place； 

- Press the  button to withdraw into the previous mode； 

- Press the   button for the third time to ensure the 
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completion of time setting, and the display indicates the current 

setting time； 

 

- Press the  button for the fourth time to start measuring 

the accumulated timing pulse with “TIME” symbol blinking on 

top left of the display. If you press the button before time 

is out, the device will enter non-accumulated mode. Pressing 

the button long to switch into time setting mode again.   

Pressing  or  button to adjust the displayed value. As 

the measuring time was set up, the device will buzz a short ring 

while measuring ends. Now the display indicates the accumulated 

value during this process while “TIME”symbol stop blinking.  

Three ways to stop measuring： 

- Under non-timing measure mode, pressing  button shortly 

for the second time to end accumulating，the measuring value 

indicates on the display. During the timing measure process, 

pressing the button shortly to enter non-timing accumulation mode. 

- Pressing  button long to enter timing mode and in the 

meantime the time is set as “000”. Confirm it and the measuring 

value is cleared. Then the default mode is to detect dose rate. 

- By choosing any other operating mode, the measuring result 

is disappeared. 
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Indicating the pulse rate：CPS/CPM 

Press the  button to convert the pulse rate unit between 

CPS and CPM.  

CPS： Pulse rate per second 

CPM： Pulse rate per minute 

 

Setup menu ：SETUP 

Press the  button to switch to manu-set mode for setting 

DATE, TIME, ALARM LEVEL, ALARM SWITCH（ ）AVERAGE TIME（T ），

Calibration factor.  

Date ：Month. Day. Year. 

Time ：Hour ：Minute ：Second 

Alarm level：1—999μSv/h (default: 100, only model 900+) 

Alarm switch：ON / OFF  

AVERAGE TIME: The setting can change reaction time of the 

device dealing with the radioactive source. The setting scale is 

ranged between 8s and 120s. The device would reduce automatically 

the value of average time on the basis of current setting along 

with increasing of radiation dose rate. For example, when the value 

is set as “8s”, the fastest reaction time can reach to 2s in the 

situation of the radiation level beyond 5uSv/h. The default value 
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is 30s.  

Calibration factor 

The default value is 2.10（Co-60） or 1.34(Cs-137)。The energy 

response for a GM tube will always be different for 

Cs-137 compared to Co60, so an instrument will always show a 

higher reading at Co-60 energies compared with Cs-137energies for 

a given dose rate, We recommend Calibration factor is 1.34 for 

Cs-137. 

Press the  button or  button to adjust value. And press 

the Enter  button for confirmation. Press the  button to 

withdraw into the previous mode.  

Generally the calibration factor can’t be revised, otherwise 

the measuring value will be inaccurate. If necessary, it must 

be done by professional engineer of radiation protection to 

calibrate the device on current calibration factor that is 

calculated under strict standard.  When calibrating, password 

is obligatory. After password is entered, the device switches 

to calibrate factor mode: “CAL”symbol blinks and “----”shows 

in the middle of the display. Press “enter” and  while the 

first “-” blinks, press  button. Then changes the first

“-”to“c”and the second“-”blinks. Now press the buttons one 

by one： ， ，The display shows“ccc-”with“-”blinking. 
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At last press the button ，it shows on the display the current 

calibration factor (i.e.:2.10). Now the first digit blinks and 

you can change the value just as ways address before. Increasing 

it will decrease measuring radiation value and vise versa. 

 

 

Maximum record ：MAX 

（Note：Model 900 simplified version don’t have this function） 

Pressing the  button witches into maximum record mode.  

 

Press the  button once to start maximum recording and 

shows “MAX” symbol on the display. Press the   button again 

to stop recording with a short beep. Now the maximum shows on the 

display with “MAX”symbol.  

 

Pressing the  button long for 2 seconds switches the 

device into timing maximum record mode. Now shows 3 digits with 

“MAX” symbol on the display while the default value is 

“060”that means 60 minute. The maximum that can be set is 999 

minute. When the first digit (hundred’s place）blinks, you can 

set the number directly.  

- Press the  button for the first time to set number at 
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tens place； 

- Press the  button for the second time to set number at 

units place； 

- Press the  button to withdraw into the previous mode； 

- Press the   button for the third time to ensure the 

completion of time setting, and the display indicates the current 

setting time； 

- Press the  button for the fourth time to start the timing 

maximum recording with “TIME” symbol blinking on top left of the 

display.  

Pressing  or  button to adjust the displayed value. 

As the measuring time was set up, the device will buzz a short 

ring while measuring ends. Now the display indicates the maximum 

value during this process while “TIME”symbol stop blinking. If 

you press the button before time is out, the device will enter 

non-timing maximum record mode. Pressing the button long to switch 

into time setting mode again.   

Ways to stop maximum recording: 

- Pressing the  button long switches into time setting 

mode and in the meantime the time is set as “000”. Confirm it 

and the measuring value is cleared.  

- By choosing any other operating mode, the measuring result 

is disappeared. 
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Data storage ：SAVE   

（Note：Model 900 simplified version don’t have this function） 

Pressing the  button once，the device stores the current 

measuring value in its internal memory. (manually operating 

single storage to record time and radiation value）. 

Pressing the  button long for 2 seconds switches to 

intervallic timing storage mode with “MEM” symbol on the display 

that shows three digits with default value of “001”(It means that 

the device automatically stores once every one minute). The 

maximum intervals that can be set is 999 minutes. When the first 

digit (hundred’s place）blinks, you can set the number directly.  

- Press the  button for the first time to set number at 

tens place； 

- Press the  button for the second time to set number at 

units place； 

- Press the  button to withdraw into the previous mode； 

- Press the   button for the third time to ensure the 

completion of time setting, and the display indicates the current 

setting time； 

- Press the  button for the fourth time to start the 
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intervallic timing storage with “TIME” symbol blinking on top 

left of the display. 

 Pressing  or  button to adjust the displayed value. 

As the measuring time was set up, the device will buzz a short 

ring while measuring ends. Now the display indicates the maximum 

value during this process while “TIME”symbol stop blinking. 

During the process of timing storage, you can still manually store 

an instant value immediately. 

Ways to stop automatic storage function: 

- Pressing the  button long for 2 seconds to enter time 

setting mode and in the meantime the time is set as “000”. Confirm 

it and the measuring value is cleared.  

- Choosing other operating mode except for dosing rate and 

pulse counting rate, you can stop the automatic storage function. 

 

 

Data transfer：USB 

（Note：Model 900 simplified version don’t have this function） 

Pressing the  button once，you were admitted to transfer 

data via USB port. Pressing again, this function was ceased.  

Under the USB transmiting mode, the device won’t response on 

pressing buttons. Unless press the    button shortly to 
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close this function or Cease the USB transmitting mode via the 

software on the computer.  

 

Clear the stored data 

（Note：Model 900 simplified version don’t have this function） 

 

Pressing the  button for 2 seconds，shows “CLEAr” on the 

display and blinks. Now press the enter button  to clear the 

data stored in the internal memory. (caution: The data can’t be 

recovered after clear. Please be sure before pressing the enter 

button.) If you switch into the clear mode by mistake, press any 

other button to withdraw.  

 

 

Power on / off   

Press the  button long for 2 seconds to power on or off.  

Once power off normally, when power on again the data stored 

before in internal memory still exists. While the device is 

powered off abnormally, it can’t be sure that the stored data 

can be retrieved.  
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Battery 

Model 900 is powered by 3 AAA batteries that you can choose 

ordinary alkaline cells or rechargeable cells (AAA model). 

The device can automatically detect the cell voltage. When 

lacking power, the battery symbol will blink on the display. It 

is suggested to change battery at once. As changing battery, the 

device can store the data in the internal memory for a minute. 

When lacking power seriously, it will power off automatically 

and you will lose the data in memory.  
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Radiation Scanner Software 

Using Radiation scanner software， you can transfer the data, 

which Model 900+ has logged in its memory, to a computer and convert 

them into list or graphic form for further processing. In addition, 

radiation scanner software can also be used to transfer the current 

radiation data to the computer for displaying and analyzing.    

（Note：Model 900 simplified version don’t have this function） 

 

USB cable connecting Radiation Scanner and computer 

 

Image shows connection between Radiation Scanner and computer 
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When connecting the Model 900+ and computer by USB cable, you 

can achieve remote monitoring and saving data very easily. This 

function offers the best way for situations with high level 

radiation which requires supervising at any time.   

USB cable length: Generally 1M cable is available. 5M is offered 

for specially request. For more length, you can use USB Extender. 

The maximum length can reach to 100M. 

 

System requirements 

1、 MS-Windows PC with USB port 

2、 CD-ROM or DVD-ROM drive for software installation  

3、 WIN 2000、WIN XP、WIN VISTA 

 

 

Software installation 

Install USB drive: Open the folder named

“Windows_2K_XP_S2K3_Vista” in CD，and execute the file

“CP210x_VCP_Win2K_XP_S2K3.exe”.   Click “Install” 

button to start installation ，all  software will release to    

“c:\SiLabs\MCU_3”. Then select“Launch the CP210X VCP Driver 

Installer”，click “FINISH”, it will appear: 
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Continue to click “Install”to finish the install process。 

If you miss the manu, please find the 

file“CP210xVCPInstaller.exe”in folder “c:\SiLabs\MCU_3”， 

double click to execute it. 

1、 Operation： After installation, you can find the 

Radiation Scanner software under path “Start→Program→

coliy” . Click it to start the program or click the LNK on 

the desktop.  

2、 Uninstall the software： Click“Start→Program→coliy

→Uninstall Radiation”，and follow the prompt to remove the 

software from your computer.  

 

 

Connecting Radiation Scanner 

Step 1：Connect the radiation scanner and computer with the USB 

cable and press the “USB” button on the device.  
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Step 2：Auto connection：Click Manu
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“Operation →Auto connection” or the icon of Auto connection. 

And the system connects the Radiation Scanner automatically.  

 

Icon of Auto connection 
on the toolbar. Click it to 
connect automatically. 

 

 

 

 Get connected ： By the way of connecting manually or 

automatically, the system presents the message window as below 

when connection succeeded.  

 

 Fail connection ： By the way of connecting manually or 

automatically, the system presents the message window as below 

when connection failed.  

 

 There are a lot of reasons for connecting failure except the 

2 reasons offered on the upper message window. More offers as 

following for your references:： 

1、 The installation of drivers is not complete. In this case 
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you can update the drivers to complete the installation.  

2、 USB cable breakdown. 

If the problems mentioned above do not exist, you may close 

the software and restart it. Try more times, generally it may 

get connected.  

Solutions to the software stallation failure 

If failed connection online after the installation of the 

 Drive and Software, please check:   

1. Check if you press the "USB" button on the Radiation 

 Scanner; if not, then press it.   

2. Open the Properties sheet (by right-clicking "My 

computer" and clicking "Properties") and click the "Device 

Manager" to check if the port status is normal. If abnormal, 

it shows a yellow triangle with an Exclamatory Mark in the 

middle. Now you need to update the Drive program. The specific 

procedure is to find the "SiLabs" file in the System 

Installation Disk (usually Disk C), then click file 

"C:\SiLabs\MCU\CP210x\Windows_2K_XP_S2K3_Vista" and run the 

"CP210xVCPInstaller" file.  During the process of updating 

drive, please close all the other application program. After 

the update is finished, check the port status in "Device 

Manager" to see if the yellow triangle is vanished. If so, the 
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port can be used normally and if not, repeat the above 

procedures. 

 

 

Read online Data 

After connection, you can start measuring online by clicking 

Manu “Operation→Read Online Data” or shortcut key “Ctrl+T” 

or icon of “Read Online Data” on the toolbar.   
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Icon of Read online data 
on the toolbar. Click it to 
read online data. 

 As for pause, click Manu“Operation→Pause” or the icon of 

pause  on the toolbar. And the system suspends reading online 

data.  

Main interface of reading online data： 
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Axis Y indicates the radiation dose rate of the scale value that 

systems adjust automatically; Axis X indicates the quantity of the 

radiation dose rate. The display area of the main interface 

illustrates at most 20 current value of the radiation dose rate.  

As to observing the foregoing value, click icon of “Current 

Tendency”  on the toolbar. On the tendency chart you can check 

all the data during a continuous measurement (there is no stop of 

pause in the process). Drag the scroll bar to check all the test 

information.  

 

In “Current Tendency” you can only observe the tendency chart 

of current data. As for previous data of the tendency chart, please 

click the “History Tendency”  on the toolbar in which you can 

check all the history measuring data of the tendency chart that 

is not deleted.   
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After clicking icon ，choose “Date” and “Time”. In “Time” 

you can check all the initial time points of measurements on a 

specific date. If there is no measuring on the date you choose, 

system shows “No Data” on the interface of the tendency chart.           

Drag the scroll-bar to check all the test information.  

Intervals Setting   

Click Manu“Setting→Intervals Setting ...”or icon  on the 

toolbar to open the interface of “Intervals Setting”.  
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Click  to set time intervals that can be chose between 2～

60S. The default value is 2 seconds. The setting value is still 

effective when you start the system next time.  

Intervals refer to the period every which the device collects 

a value when reading online data.   

 

Alarm Setting 

Click Manu “Setting →Alarm Setting...”or icon  on the 

toolbar to open the interface of “Alarm Setting”.  

 

Pitch on “Alarm”to set alarming function. And then set 

“Threshold”. The default setting is alarm off with Threshold 
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value of 5μSv/h that can be chose between 1～1000μSv/h with the 

increment of 1μSv/h.  

 

As alarm sets on, the device will be alarming when it detect 

that the radiation dose value exceeds the setting value of the 

alarming threshold, recording the radiation value and time point 

displayed on the left side of the interface. The system can record 

at most 255 alarming value. When the recorded data are over that, 

system will automatically delete the foregoing values.    

 

Save Online Data 

The Online data can be saved in the form of EXCEL or TEXT for 

further analyzing.  

Click Manu“File→Save Online Data...”or icon  on the 

toolbar popping the window for saving.  

This function is to save the data reading online continuously 

in the form of  Excel（.xls）or  Text（.txt）in your computer.  
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Read Radiation Scanner Recorded Data 

On connection, click Manu“Operation→Read Radiation Scanner 

Recorded Data”or click icon  on the toolbar to read data stored 

in Radiation Scanner. When you do so, if the system is reading 

online data, it will give a prompt as below:  

 

Click button “YES（Y）” to start reading the recorded data 

while click“NO（N）”to give up. Otherwise system will read 

the recorded data directly.  

When reading, please wait a moment for the system reaction. The 

reaction time depends on the data volume stored in the Radiation 

Scanner. More time requires for more data, vice verse. During this 

process, system can’t carry out other operation due to the 

time-lag.    
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On the interface system displays the “Manual Recorded Data” 

on top and “Auto Recorded Data” below. If there is only one kind 

of data stored in Radiation Scanner, the system will display the 

information of this kind of data on the interface and neglect the 

other kind of data.  

Every yellow sold bar represents a value of the radiation dose 

rate. On top of it is its detailed information such as date, time 

and dose rate. Drag the scroll bar to check all the data 

information. 

 

Save Radiation Scanner Recorded Data 

After system reading Radiation Scanner Recorded Data, you can 

save them in the form of Excel or Text in your computer for further 

analyzing.  

Click Manu“File→Save Radiation Scanner Recorded Data...”
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or icon  on the toolbar popping the window to save both Manual 

recorded and Auto recorded data. Click Manu “File → Save 

Radiation Scanner Manual Recorded Data...” or “File→Save 

Radiation Scanner Auto Recorded Data...” to save one kind of the 

data.  

When you exit the software, if the data reading from the 

Radiation Scanner have not been saved, system will pop a 

prompt asking you if to save them. Click “ YES（Y）” to save 

or click “NO（N）”to give up saving and exit the system.     

 

Delete Radiation Scanner Recorded Data 

Radiation Scanner has limited memory so that you have to delete 

the data that have been saved in your computer to release the 

internal memory of Radiation Scanner for recording new data. And 

the data can’t be retrieved after being deleted, so be care of 

this operation.  

Click Manu“Operation →Delete Radiation Scanner Recorded 

Data” or icon  on the toolbar，system will pop a prompt window 

as below asking if you are sure to delete the data.  
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Click button“YES（Y）” to delete the data recorded in the 

Radiation Scanner, while click button “NO（N）”to give up. After 

deleted, system will give a prompt note: “erase storage data 

finish” 

 

Option 

Click Manu“Setting →Option ...”to open the sub-interface of 

option that contains of 3 module Manu: Save Setting, Data 

Management and Connection Setting.  

 

1、Save Setting 

 By the mode of Manual Save system will pop a prompt note 

asking if to save the data reading online when you exit the system; 

by the mode of Auto Save system will save automatically the data 

when exit the software.  

Click radio button “Auto Save”popping a prompt window to choose 
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a folder for saving data automatically.   

 

Click “YSE” for system recording the folder to save data 

automatically while click “NO” to give up saving automatically. 

System will keep this folder as the default address for saving 

other data.  

 

Default file type：System saves the data in Excel that is the 

default file type. You can change the file type by choose “.txt” 

in the module of File Type. Then system will save data in the type 

that you choose when saving automatically.   

2、Data Management 

 

The column of Date displays all the day on which you collect 

radiation dose rate in your computer. Click a date value system 

shows all the starting time of the data detecting on that day in 



Radiation Scanner Software 

the column of Time and the detailed data information of a specific 

initial time in the column of Information such as Start Time, End 

Time, Max Value, Min Value and Count.    

Click the starting time to make the “Save” button available.  

And click “save” button popping a dialog window to save the data.  

Click the time of the data you want to delete and then click 

“Delete” button popping a dialog box as below. Click “YES(Y)” 

to do so while click “NO(N)”to give up.  

 

 

The function of systemizing is to release the disk space. The 

read online data save in the disk of your computer. When you delete 

them, the disk space won’t be released totally so that you need 

to click “Systemize” button to make the system clear and release 

it. When this has been done, system will give a prompt note as 

below： 

 

 3、Connection Setting 

 Connection setting refers to the operations after connection 
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containing 3 sub-options:  

 None ：System does no operation after connection, waiting for 

user to operate.  

 Read Online Data：System reads online data immediately after 

connection.  

 Read Radiation Scanner Recorded Data ：System reads Radiation 

Scanner Recorded data immediately after connection.  

 

 

About   

Click Manu“Help→About”or shortcut key “Ctrl+H” 



Radiation Scanner Software 
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Technical data： 

Ray types α、β、γ and  Χ rays 

Range Radiation dose rate: 0.01µSv/h - 1500µSv/h

Impulse dose rate: 0-30,000cpm, 0-5,000cps

Radiation dose accumulation: 0.001µSv –

999999Sv 

Impulse dose accumulation: 0-999999 

sensitivity 108pcs impulse or 1000 cpm/mR/hr in 

Cobalt-60 radial environment with power of 

1µSv/h. 

Alpha ray:    from 4 MeV 

Beta ray:      from 0.2 MeV 

Gamma ray: from 0.02 MeV 

X ray:           from 0.02 MeV 

Ray 

selection switch 

α、β、γ and Χ rays selection 

sensor Halogen filled detector 

Output port USB Port (with special USB extend cable, can 

extend to 100M) 

Display 6-digit display (LCD),  numeric with all 

inspection data, with bar chart. 



Technical data： 
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Alert Can set alert value free, default 

set:5µSv/hr 

Accuracy Typical 15% 

Storage Can store 2000 data automatically or by 

manually 

Detector 

work tem. 

-40℃   to 75℃    

weight 200g 

Dimension Length 170mmXwidth 74mmXheight 30mm 

Power 3 AAA batteries 

Warranty 1 year 
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Warranty 

Coliy technology GmbH assure you that each meter we 

made has no defects in materials and technics .  

The length of warranty is one year after the meter was 

shipped to the customer. 

Coliy technology GmbH reserved rights to change 

designs at any time.  

Jan.2009 
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Appendix 

Radiation unit conversion formulas 
 

UNITS OF RADIATION MEASUREMENT 

 

The curie is the number of particles per  second from 1 gram of Radium = 

3.7 x 10 E10 counts/second = 37 billion cps  =  37 billion Becquerel. 

1 Becquerel (Bq) = 1 count per second = 1 event per second 

1 microcurie = 1 uCi = 37,000 Bq = 37,000 cps. 

1 microcurie = 2.22 x 10E6 disintegrations / minute = 2,220,000 cpm. 

1 nanocurie = 1 billionth of a curie = 2,220 disintegrations / minute. 

1 picocurie = 2.2 disintegrations / min. 

 

 

 

 Dosage units: 

Gray (Gy) = 1 Joule/kg 

Sievert (Sv) = Gray x QF, where QF is a "quality factor" based on the type 

of particle. The Sievert is a measure of biological effect. 

 

 QF for electrons, positrons, and xrays = 1 QF = 3 to 10 for neutrons, 

protons dependent upon the energy transferred by these heavier particles. 
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QF = 20 for alpha particles and fission fragments. 

 

Converting older units: 

 

1 rad = 1 centigray = 10 milligrays ( 1 rad = 1cGy = 10 mGy ) 

1 rem = 1 centisievert = 10 millisieverts ( 1 rem = 1cSv = 10 mSv ) 

 

1 mrad = 10 μGy 

Nominal background radiation absorbed dose of 100 mrad/year = 1 mGy/yr. 

Nominal background radiation dose biological equivalent of 1mrem/year = 

10µSv/yr. 

Occupational whole body limit is 5 rem/yr = 50 msv/yr. ( Recently proposed 

that levels be reduced to 2 rem/yr.)   

2.5 mrem/hr or 25 µSv/hr is maximum average working level in industry. 

Exposure rate from Naturally Occurring Radioactive Material (NORM) ; an 

empirically derived conversion factor for Ra-226 decay series: 1.82 

microR/hour = 1 picoCurie/gram. 

mR/h=10μSv/h 

mR=10μSv 

 

sievert’s meaning： 

In physicals, three types of radioactive rays are know: α、β、γ rays (X ray 
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belong to low energy scale ofγ ray.) They differ not only in their physical 

characteristics but also in their effects on humans. To make these three ray 

types comparable in their effects on humans, a value has been created which 

defines the biological effects of rays: it is referred to as dose equivalent 

whose unit is sievert (called equivalent dose). 

sievert (Sv) 

1 Sv=100 rem 

rem （roentgen equivalent man）  

 

Calibration factor for Co-60 or Cs-137 

The energy response for a GM tube will always be different for 

Cs-137 compared to Co60, so an instrument will always show a higher 

reading at Co-60 energies compared with Cs-137energies for a given dose 

rate, all instrument manufacturers have the same problem, that is why they 

state in their literature that  their instrument is accurate either at Cs137 

energies or Co-60 energies  ( normally Cs-137 ), an instrument will not 

indicate accurately at any other energy ( other than possibly one or two lower 

energy bands ). We recommend Calibration factor is 1.4 for Cs-137 or 2.1 for 

Co-60. 
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